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Attention 

 

Please read this manual carefully before installation and operation. It is a detailed 

introduction of configuration, principle, specification, installation, etc. of Sealand mass flow 

meter. 

The meter meets the following standards, 

EN 60079-0:2012+A11:2013     EN 60079-1:2014    EN 60079-11:2012 

IEC 60079-0: 2011             IEC 60079-1: 2014   IEC 60079-11:2011 

It is produced according to National Regulation of Coriolis Mass Flow Meter GB/T 

31130-2014 and Ex-proof approved. Each sensor has its own paired transmitter. Please do 

not change any component in case of failure. 

Please cut off the power before installation. Keep junction box intact and wiring correct; 

make sure no gasket, o-ring or holding screw missing, and electricity ex-proof device in good 

condition during the installation. 

 

Mark: This is a general manual for Sealand meter, with all configuration described, and 

some configuration is optional. Please operate according to the meter purchased.

 





  

  

www.engematic.com.br 

 - 1 - 

Chapter 1 Specifications 

 

1.1 Introduction 

Sealand meter is designed and produced according to world’s latest Coriolis technology with 

better appearance, stability and accuracy to measure mass flow rate of a fluid traveling 

through a tube, widely applied to alternative energy, oil & gas, chemical, food & beverage, 

industrial energy, marine, power, pulp & paper, water & wastewater industries, etc. 

 

1.2 Operating Principle 

Mass flow meter measures the mass based on Coriolis effort. The operating principle 

involves inducing a vibration of the tube through which the fluid passes. The vibration, 

though not completely circular, provides the rotating reference frame that gives rise to the 

Coriolis effect. While specific methods vary according to the design of the flow meter, 

sensors monitor and analyze changes in frequency, phase shift & amplitude of the vibrating 

flow tubes. The changes observed represent the mass flow rate and density of the fluid.  

 

1.3 Features 

● Measurement is not influenced by flow density, viscosity, temperature & pressure; 

● Low requirement of straight pipe, because nothing inside holds back the flow; 

● Low power dissipation; stable zero point; better accuracy; 

● Meter is ARM system with 3 calculators to count density, temperature & mass flow rate; 

● Transmitter is assembled by surface mounting technology with self-inspection function; 

● ATEX approved(excluding Transmitter F210). Cert. No. TPS 18 ATEX 04516 001 X 
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          II 2G Ex db [ib] IIC T6...T1 Gb (Transmitter) 

               Ex ib IIC T6...T1 Gb (Sensor) 

 

Specific Conditions of Use 

1) WARNING-DO NOT OPEN TRANSMITTER WHEN ENERGIZED. 

2) When the equipment is installed, precautions shall be taken to ensure the ambient 

temperature of the transmitter meets the marked temperature range, taking into account 

process fluid effects.  

3) The cable entry holes of transmitter must be connected by means of suitable cable entry 

devices and which are covered by a separate conformity ATEX/IECEx certificate with the Ex 

d explosion protection property as the certification and in minimum IP67. 

4) The unused entry holes of transmitter must be blanked by means of suitable blanking 

elements and which are covered by a separate conformity ATEX/IECEx certificate with the 

Ex d explosion protection property as the certification and in minimum IP67. 

5) The external earth connection facility of transmitter shall be connected reliably.  

6) For temperature class T2 and T1, to be energized with cable and cable gland suitable for 

temperature 100°C. 

 

1.4 Operating Environment 

Atmospheric pressure: 85kPa~106kPa 

Ambient temp.: Refer to Chapter 1.6 

Relative humidity: 5%~95%, non condensing 
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1.5 Operating conditions 

Fluid :                       

Fluid temperature:          

Nominal pressure:           

Supply voltage:               

                           

Outputs:                

 

  

Liquid/Gas 

-200°C~+200°C (higher temp. model is customizable) 

4MPa or 25MPa (Customizable) 

AC 85~265VAC, 50/60Hz or 

DC 12~24VDC(±5%), 5W 

Pulse 0~10KHz, RS-232C, RS-485, 4-20mA & HART (optional) 



 

 www.engematic.com.br - 4 -

 

1.6 Temperature Class 

Requirements for each class: 

Table 1-1 Temp. Class Table 

1.7 Model Designation 

The mass flow meter consists of a F23 series transmitter and a CG/CNG series sensor. 

 

F23  *  *  *  *** 

1  2  3  4  5 

1: F23 series transmitter 

2: Display 

  0: without display 

  1: with display 

3: Voltage input 

  A: AC 

  D: DC 

4: Communication mode 

Temp. Class Fluid Temp. Min. Ext. Length 
Transmitter Operating Temp. 

Display No Display 

T6 -200~+60°C 10cm -30~+45°C 

T5 -200~+80°C 10cm -30~+45°C 

T4 -200~+105°C 10cm -30~+45°C 

T3 -200~+138°C 10cm -30~+45°C 

T2 -200~+238°C 50cm -30~+60°C -30~+85°C 

T1 -200~+388°C 50cm -30~+60°C -30~+85°C 
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  N: Routine 

  I: 4-20mA 

  H: HART 

5: Sensor caliber (DN006~200) 

 

CNG - ** 

 1    2 

1. Specially designed for CNG application 

2. Nominal diameter (15, 20) 

 

CG - *** 

 1   2 

1. For all application 

2. Nominal diameter (06, 15, 25, 32, 40, 50, 80, 100, 150, 200) 

 

Chapter 2 Composition 

 

The meter consists of mass flow sensor and transmitter, adopting executive standard GB/T 

31130-2014. 

 

2.1 Mass flow sensor 

Mass flow sensor is a phase-sensitive resonant sensor based on Coriolis effect, composed 
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of vibration tube, signal detector, concussion driver, structural support, shell, etc. 

2.1.1 Main parameters 

Item  Parameters 

Accuracy class 0.1, 0.2, 0.3, 0.5 

Vibrating tubes Stainless steel 316L 

Pressure drop ≤0.2MPa 

Case protection IP67 

Ex-mark II2G Ex db ib IIC T1...T6Gb, Ex db ib IIB/IIC T1...T6 Gb 

Table 2-1 Main Parameter of Sensor 

  



  

  

www.engematic.com.br 

 - 7 - 

2.1.2 Sensor Dimension 

There are 3 different shapes, CNG, Triangle and U type. 

               

 

 

 

 

 

 

Pic. 2-1 Shape of Sensor 

Table 2-2 Dimension/ mm 

2.2 Mass flow transmitter 

Mass flow transmitter is a micro-programming-centered electronic system, which supplies 

thrust to sensor, transforms sensor signal into mass flow signal & others, and improves 

Shape 
Model 

No. 
DN Flow Range (kg/h) 

Dimension 
Flange 

(Standard DIN2635) Bolt 

A B C d d0 n-d1 

CNG CNG-15 15 300~3000 136 326 210    M32*1.5 

TRI 

CG-06 6 120~1200 162 319 235 95 65 4-φ14 M12 

CG-15 15 300~3000 188 369 293    M32*1.5 

CNG CG-20 20 945~9450 200 472 370    M42*2 

TRI CG-25 25 1200~12000 211 574 448 115 85 4-φ14 M12 

U 

CG-50 50 3000~60000 556 708 501 165 125 4-φ18 M16 

CG-80 80 75000~150000 830 970 501 200 160 8-φ18 M16 

CG-100 100 12000~2400000 763 1162 709 200 160 8-φ22 M20 

A 

B 

C 

C 

B 

A A 

B 

C 

Flange 

n-d1 

d 

d0 
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accuracy in accordance with temperature parameter. 

It’s composed of switching power supplier, guard grating, core processor board, display 

module, etc., installed in a ex-proof junction box. Switching power supply offers power for 

transmitter; safe grating isolates sensor and transmitter intrinsically; core processor detects 

& processes sensor phase signal, sends mass flow signal and process communication. 

2.2.1 Main Features 

● Capable of configuration modification for different fluids; 

● Capable of flow rate, density & temp. measurement; 

● Capable of RS-232, RS-485 ModBus, 4-20mA & HART communication; 

● Capable of mass total, volume total & density calculation, with 3 calculators; 

● Capable of recording real-time total. 

2.2.2 Basic Parameters 

(1) Transmitter 

Power: ≤ 5W 

Display: Display with wide angle of view, wide temperature & backlight, to show flow rate, 

unit, total, alarm, alarm type, etc.  

Switches: Optical switches SET & SELECT for all setup & operation. 

(2) Setup operation 

There are 2 ways for setup, SET/ SELECT & configuration software. 

(3) RS-485 & HART communication port 

The meter is capable of communication with PLC through RS-485/HART communication 

port. Please contact us for the protocol if need. 

(4) Pulse signal output 
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It is passive OC gate output, capable of electrical totalizer connection. 

 

2.2.3 Transmitter Dimension 

There are 2 different configurations, F210 & F23X. 

 

Pic. 2-2 Dimension of F210 

 

Pic. 2-3 Dimension of F23X 

 

Chapter 3 Installation 

 

There are strict safety requirements for the design, test, and power supply of mass flow 

meter; thus, please read this manual carefully and do accordingly before installation for safe 

operation.  

 

3.1 Attention 

a) Please take the safety requirements of flow rate, related device and environment into  

consideration before site selection & installation; 
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b) Installation and maintenance shall be done by professional technician; 

c) Connect sensor with pipes correctly, without any leakage; 

d) Take measure to avoid electric shock; 

e) Fluid pressure shall be no more than the value marked on nameplate; 

f) Installation tools meets safety requirement. 

 

3.2 Before Installation 

a) Make sure the flange, case & wire plug undamaged. 

b) Make sure the wiring & wiring terminal tight and undamaged. 

c) Make sure the model number on nameplate is same as ordered. 

Mark Description Danger 

 
EX-Danger Area 

Operate according to this manual to meet Ex-proof 

certificate requirement. 

 
High Pressure Possibility of electric shock. 

 
Routine Danger Possibility of routine danger which may cause injury. 

 

Surface Overheating or 

High Temperature 
Possibility of scold. 

Table 3-1 Danger Mark 

 

3.3 Installation 

3.3.1 Installation Steps 

a) Choose correct installation site, taking installation area, pipeline, transmitter location &  

valve location into consideration; 
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b) Install the meter according to direction mark on sensor; 

c) Install the sensor & transmitter on pipeline; 

d) Connect transmitter & sensor with 9-pin cable; 

e) Start. 

3.3.2 Site selection 

a) Sensor stays away from mechanical vibration source, for example, pump. Use flexible  

pipe to connect meter with pipeline if inevitable. The housing of meter must be standalone, 

out of touch with any other device. There must be 3 times the size of sensor between 2 

sensors if there are many flow meters on the same pipeline, to avoid resonance. 

b) Do not install sensor on pipeline that easily expands with hot and contracts with cold, 

especially near expansion joint, which leads to a worse stability.  

c) Sensor stays away from industrial electromagnetic field, such as large generator and 

transformer, better 5m at least. Such device influences the performance of drive coil and 

pickoffs. Make sure magnetic field intensity less than 400A/m. 

d) Sensor shall be installed on lower pipeline, to be easily full of fluid.  

e) Make sure Ex-mark meet application requirements if in hazardous area. 

f) Build a sunshade if the meter is under direct solar radiation. 

g) Keep the meter from corrosive liquid. 

3.3.3 Installation methods 

The sensor can not be a support point of the whole pipeline; the pipeline shall support itself. 

Meanwhile, sensor shall not be under overlarge tension stress during the connection, since 

pipeline expansion will make this stress heavier. 

It is recommended to install the meter as follow according the different fluid. 



 

 www.engematic.com.br - 12 -

 

 

Liquid             Gas             Slurry 

Pic. 3-1 Installation Methods 

a) For liquid, install the sensor downwards, to avoid air gathering in tubes. 

b) For gas, install the sensor upwards, to avoid condensate gathering in tubes. 

c) For slurry, install the sensor on vertical pipe, to avoid particle gathering in tubes.  

3.3.4 Ground 

Current signal from sensor is extremely weak, only several millivolt even when full range; 

thus, sensor shall be well grounded to filter other signals. There are 2 requirements as 

follows. 

a) The electric potential of ground terminal of sensor and transmitter shall be the same as 

that of fluid. 

b) Make the ground zero potential, to reduce interference. It’s easy to meet this requirement, 

because generally the pipeline is metal and grounded itself already. However, the meter 

shall be grounded itself if there is strong interference. Meter ground cable shall be copper 

material, with section over 4mm2, and not connected with common ground cable of motor, 

etc.; ground resistance shall be less than 10Ω.  

 

3.3.5 Other Requirements 

a) Make sure the meter coaxial with pipeline, and axis deviation ≤1.5mm for DN50 or smaller 

models.  
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b) Make sure the gasket of high corrosion resistance, and not touch tube interior. 

c) Fasten bolt & nut, and make sure the thread intact. Select a suitable torque spanner for 

the fastening. 

d) Isolate the meter during welding or flame cutting of close pipeline, to avoid heating. 

 

Chapter 4 Wiring & Circuit 

 

4.1 Wiring 

Only the sensor-transmitter- connection cable is provided with the meter; please prepare the 

power cable and others yourself. 

 

4.1.1 Reverse Display Module 

This chapter is for transmitter with display. Please rotate the front cover anti-clockwise, 

remove screws & 6P wire, and reverse the display module if you need the display reverse. 

 

Pic. 4-1 Display Module 

Display Module 

LCD Module Cover 

Front Cover 
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4.1.2 Power cable 

The power supply can be 85~265VAC or 12~24VDC. Section area of power cable shall be 

more than 0.8mm2, and length no more than 100m. 

There are 2 kinds of transmitter, F210 & F23X. Please refer to the following diagrams 

respectively according to the model purchased. 

 

Pic. 4-2 Wiring diagram of F210 

Open the back cover of F23X, and you will find power module on the top and adapter 

module on the bottom. 

 

 

 

 

 

 

 

Pulse Signal Input: (FO-, FO+) 

Guard Grating 

Pulse Signal Output 

RS485 Comm. Port 

Zero Button 

Mainboard 

Power Board Voltage Input 

Power Supply 

Sensor Signal Input 

Power Input 

RS-485: A(+), B(-) 

Sensor Signal Input 

Power Module Voltage Input Adapter Module 

HART/4-20mA (Optional) 
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Ground Connector 

Voltage Output 

Zero Button 

DC Power Connector (12~24V) 

Reset Button Zero Button Zero Button 

 

 

 

 

 

 

 

 

Pic.4-4 Wiring Diagram of F23X Power Module 

 

4.1.3 Wiring Requirements 

a) Cut off power before wiring; 

b) Use correct wire; 

c) Thread wires correctly: Loosen locknut; remove block board; thread wire through  locknut, 

rubber ring and wire plug all at once; do the wiring; settle wires; tighten locknut. 

d) Do not damage insulating layer when pare the cable. Do not pare shielding layer of 

sensor signal input wire if wirable. 

 

Pic.4-3 Wiring Diagram of F23X Adapter Module 

AC Power Connector (85~265V) 

DC Power Module 

Fuse 

Ground Connector 

Voltage Output 

Reset Button 

AC Power Module 
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4.2 Circuit 

4.2.1 Connection Cable 

Sensor and transmitter are connected through a 9-pin shielded cable( the shielded cable is 

divided into 3, so the transmitter end is actually a 12-pin). Do not use other cable for the 

connection, in case of accuracy failure; do not hang this cable over motor or other power 

equipment, in case of electromagnetic influence; the max. length could be 150m. 

 

4.2.2 Terminal definition 

Open the back cover of the transmitter and junction box of sensor, and you will see the 

terminals as follows. Please wire accordingly. 

                     

Pic. 4-5 Sensor Terminal Board          Pic. 4-6 F23X Transmitter Terminal Board 

The definition is as follows. 

Code L+ L- R+ R- D+ D- TPE S2 S1 C1 

Color Grey Purple White Yellow Blue Red 
Black 

(Shield) 
Black Green Orange 

Function 
Left pickoff 

detection 

Right pickoff 

detection 
Coil drive Temp. detection 

Table 4-1 Sensor Terminal Definition 
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Table 4-2 Transmitter Terminal Definition 

 

4.2.3 Connection with Pulse Receiver(Count) 

The meter can work with a pulse receiver(Count). The connection is as follows. The 

resistance value is up to the cable length & the max. input pulse frequency of receiver. 

Current 10mA is suitable for most receivers; however, you can reduce the resistance value 

when the cable is long. The max. current could be 50mA. Please use the fixed frequency 

output function to check if the cable length & resistance value is suitable(refer to Chapter 7.6 

for more details).  

 

Pic. 4-7 Connection Diagram for Meter & Pulse Receiver 

Code R+ R- PE L+ L- TPE S2 S1 C1 DPE D+ D- 

Color White Yellow 

Black 

(Shield) 
Gray Purple 

Black 

(Shield) 
Black Green Orange 

Black 

(Shield) 
Blue Red 

Function 
Right pickoff 

detection 
Left pickoff detection Temp. detection Coil Drive 

Mass Flow Meter 
R 

Receiver 

IN 

COM FO- 

FO+ 

V+ 
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4.2.4 Start 

Please check following items before operation, and operate according to relevant rules. 

a) If the meter is damaged during shipment and installation; 

b) If the voltage is same as marked on nameplate; 

c) If the fuse is correct; 

d) If the meter is grounded properly. 

If everything is fine, please open all valves, make the pipeline full of liquid and then power on 

the meter for warm-up for 20min before operation. Finally, conduct zero calibration after first 

start, and shall do it again if the meter is moved to another site. 

Preparation for zero calibration: 

a) Power on the meter for approximately 20min for warm-up; 

b) Run the process fluid through the sensor until the sensor temperature reaches the normal 

process operating temperature. 

c) Close the shutoff valve downstream from the sensor. 

d) Ensure that the sensor is completely filled with fluid and the process flow has completely 

stopped. 

Please refer to Chapter 7.8 for detail operation of zero calibration. 

 

Mark: Zero calibration is quite important, or the accuracy may be bad. It is highly 

recommended to check the zero point each 3 months, and do zero calibration if the zero 

point changes a lot. 
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Density 

Current Value 

Total 

Interface 2 

Flow Rate 

Chapter 5 Meter Interface 

 

5.1 Operating Interface 

There are 2 optical switches(SET & SELECT) on the operating panel, and a bicolor indicator 

in the middle. 

 

 

Pic. 5-1 Operating Panel Diagram 

5.2 Interfaces 

5.2.1 Main Interfaces 

There are 3 main interfaces.  

 

 

Pic. 5-2 Main Interfaces 

 

OLED Display 

Temp. 

Unit of Measure 

SET Optical Switch 

Optical Receiver LED (Status LED)Optical Switch Indicator 

SELECT Optical Switch 

Process Variables 

Interface 1 Interface 3 
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5.2.2 Setup Interface 

There are 2 options, User & Config.  

Use Setup: Display Setup, System Setup, Troubleshooting & Sensor Status. 

Config. Setup: Meter Setup, Communication Setup, Pulse Setup, Parameter Backup & 

Password Setup. 

Original password: User 0001; Config. 0002. 

Password initialization: Un-plug & plug the meter, press reset button on display board for 3s 

once it shows version number on screen. All passwords will be initialized as factory set in 

this way.  

 

 

 

Pic. 5-3 Setup Interface 

 

Chapter 6 Configuration Software 

 

Please download the software from Sealand website www.chinasealand.com. 

6.1 Connection Between Meter & Computer 

Connect the meter and computer with a USB-to-RS485 converter( converter A+ end to 

transmitter A+ end, B- to B-, and GND to GDN); turn to device manager of the computer to 

check COM port connected with meter. Start the software, select the right COM port and 

click Connect; do not change any other parameters. 

You can click Connect on the tool bar to disconnect or connect again; the connection status 

is shown at the bottom of the software. 

http://www.chinasealand.com/
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6.2 Process Variables Monitoring 

This interface comes automatically after the meter and computer are connected, or you can 

click Functions > Process Variables on the tool bar to call out. It shows real-time Flow 

Rate, Total, Density & Temperature. 

6.3 Mainboard Information 

This interface is to read mainboard number and mainboard real-time operating temperature. 

Click Functions > Mainboard Info on tool bar to call out. 

 

Chapter 7 Operation 

 

The SET and SELECT optical switches are used to navigate the transmitter display. To 

activate an optical switch, touch the glass in front of the optical switch or move your finger 

1~2mm over the optical switch close to the glass.  

The indicator will flash green when the display is timeout, will be solid red when one switch is 

activated, and will flash red when one switch is activated for 3s(hereafter referred to as long 

activate). Solid-red or flash-red means that the indicator has identified your operation; thus, 

please remove your finger afterwards, and do not touch the other optical switch, or it will be 

recognized as another operation. 

The general operation is listed as follows. 

On Main Interfaces 

Activate SET to alternate mass and volume values. 

Activate SELECT to alternate main interfaces. 

Long activate SELECT to go to Setup Interface. 
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Table 7-1 Operation Table 

 

 

Mark: 

1. The display will timeout without any operation in 5 min. 

2. During numbers input, the decimal point will come up automatically if the first digit is 0; if  

not 0, please activate SELECT until decimal point shows up. 

 

7.1 Calibration Factor Setup 

There are 2 calibration factors, factory & user. Each meter has its own factory calibration 

factor marked on calibration certificate & nameplate of sensor, and the original user factor is 

1 for all meters. Please use user factor for calibration, and do not change the factory factor.  

 

Formula:  

)
ValuealRe

ValuealReValueMeasured
(1

FactorOriginal
FactorNew 

−
+

=  

Mark: Customer can use the meter directly without setting new factor, but in the following 2 

Long activate SET for total reset. 

Back to Main Interface Long activate SET & SELECT at the same time. 

Select Submenu, 

Parameters & Numbers 

Activate SELECT to select the submenu, parameters or 

numbers. 

Activate SET to go to submenu or save parameters/numbers. 

Save setup Long activate SET to save the modified setup. 

Back or Exit Long activate SELECT. 
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cases: 1. Transmitter is replaced; 2. There is a big difference between measured value & 

real value.  

● By transmitter 

Config > Meter Serup > Meter Parameters > User Cal. Factor > Mass Factor/ Volume 

Factor > Set > Save. 

 

Detail Steps: 

1. Long activate SELECT to go to the Setup Interface; 

2. Activate SELECT until Config is selected; 

3. Activate SET to go to the password input box; 

4. Activate SELECT to select the right number, then activate SET to confirm, and it will  

come to next digit automatically; 

5. Activate SET after you input all digits of password to go to the submenu; 

6. Meter Setup will be selected directly because it is the first item on this submenu(activate  

SELECT until it is selected, if not); 

7. Activate SET to go to the submenu of Meter Setup; 

8. Activate SELECT until Meter Parameters is selected; 

9. Activate SET to go to the submenu of Meter Parameters; 

10. Activate SELECT until User Cal. Factor is selected; 

11. Activate SET to go to the submenu of User Cal. Factor; 

12. Activate SELECT to select Mass Factor or Volume Factor; 

13. Activate SET to go to the factor setup interface; 



 

 www.engematic.com.br - 24 -

 

14. Activate SET again to go to the new factor input box; 

15. Activate SELECT to select the right number, then activate SET, and it will comes to next  

digit directly; 

16. Long activate SET after you input all digits of the new factor to save the setup. 

17. Done; 

18. Long activate SELECT to go back, or long activate SET & SELECT at the same time to  

go to the main interface directly. 

● By software 

Tool bar > Functions > Configuration > Flow Rate > Factory Cal. Factor/ User Mass. Factor/ 

User Vol. Factor. 

 

7.2 Density Calibration 

● By software 

Tool bar > Functions > Calibration > Density Calibration 

Every parameter in this interface is calibrated in professional calibration lab. Please do not 

modify, or consult us if you have to. 

7.3 Flow Cutoff Setup 

There are some factors that may cause the meter count even when there is no fluid flowing 

through the sensor, such as the installation, vibration, etc; thus, a min. flow cutoff value is 

necessary. The meter won’t count itself when the flow rate is less than this value. 

● By transmitter 

Config > Meter Setup > Flow Parameters > Flow Cutoff > Mass Cutoff/ Volume Cutoff. 

● By software 

Tool bar > Functions > Configuration > Flow Rate > Mass Cutoff/ Volume Cutoff. 
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7.4 Max. Frequency of Pulse Output Setup 

● By transmitter 

Config > Pulse Setup > Max. Frequency of Pulse Output. 

● By software 

Tool bar > Functions > Configuration > Frequency > Max. Fre. Of Pulse Output. 

 

7.5 Pulse Equivalent 

The factory set equivalent is suitable for most application. The pulse receiver may not detect 

the pulse when the value is too small, and it may lead to lack of measurement resolution 

when it is too big. 

How to calculate a suitable equivalent: 

ceiverRePulseofFrequencyWorking.Max

RateFlowWorkingalRe.Max
*2.1EquivalentPulse =  

● By transmitter 

Config > Pulse Setup > Pulse Equivalent. 

● By software 

Tool bar > Functions > Configuration > Frequency > Pulse Equivalent. 

 

7.6 Fixed Frequency Output 

This is to output a simulative fixed frequency to help test the count accuracy of pulse 

receiver and the max. receiving frequency.  

● By transmitter 

Config > Pulse Setup > Fixed Pulse Output Test > Fixed Frequency Setup. 



 

 www.engematic.com.br - 26 -

 

● By software 

Tool Bar > Functions > Output Test > Fixed Frequency Test > Modify > OK > Fixed Output. 

 

7.7 Current Setup (4-20mA/ Optional) 

This function is available only when the meter is configured with 4-20mA output.  

There are 5 submenus: 

Fixed Current Output Value: To set a simulative current value. 

Fixed Current Enable: To simulate a current output for test. The current will disappear in 

1min; enable again if you need it once more. 

Output Options: To select which parameter you need to be inputted as current, including flow 

rate, density & temperature. 

Upper Limit: To set a value for 20mA. 

Lower Limit: To set a value for 4mA. 

 

● By transmitter 

Config > Current Setup. 

● By software 

Tool Bar > Functions > Configuration > Current. 

 

7.8 Flow Direction 

There are 4 options, forward, reverse, absolute value & bi-direction. 

● By transmitter 

Config > Meter Setup > Flow Parameters > Flow Direction. 
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● By software 

Tool bar > Functions > Configuration > Flow Rate > Flow Direction. 

 

7.9 Zero Calibration 

● By transmitter 

There are 2 methods to do zero calibration by transmitter. 

1. Config > Meter Setup > Calibration > Zero Calibration > Start. The indicator will flash  

green during the calibration. 

2. Open the back cover, press the reset button on power board, the red light blinks, and then 

calibration begins. Please kindly note that the meter is not ex-proof if you take off the back 

cover; thus, please do not conduct this method in hazardous area. 

Please refer to Chapter 4.2.4 for the preparation before zero. 

● By software 

Tool bar > Functions > Calibration > Zero Calibration > Zero. 

7.10 Total Reset 

There are 2 totals, mass & volume. The other will be reset automatically if either is reset, and 

the reset is irrecoverable. 

● By transmitter 

Method 1: on any main interface, long activate SET, and then comes the total reset interface. 

Method 2: Config > Meter Setup > Total Reset. There are 2 options here. Go to Reset Total 

for total reset; go to Setup if you want the total password-protected.  

There are also 2 options for Setup. Go to Password or Not to enable/ disable the 

password( the total can be reset without password if disabled); go to Reset Password to 
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change the password. The original password is 0003. 

Mark: This password only works for Method 1. This is no need to input password with 

Method 2. 

● By software 

Tool Bar > Functions > Total Reset.  

 

7.11 Volume Calculation 

Mass flow meter measures mass directly, but it can also show in volume. There are 2 

options for volume calculation, by fixed & real-time density. Fixed density is the one you 

input, which does not change, and the real-time density is the one the meter measures, 

which changes when the flow, environment, etc. are different. 

● By transmitter 

Config > Meter Setup > Flow Parameters > Volume Calculation > Density Options > Fixed/ 

Real-T. 

● By software 

Tool Bar > Functions > Density Options > Fixed Density/ Real-Time Density > Save. 

 

7.12 Units of Measure 

● By transmitter 

Config > Meter Setup > Units of Measure. 

 

● By software 

Tool Bar > Functions > Configuration > Flow Rate. 
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The following units are available. 

Name Units Available 

Mass Total G, kg, T, St, lt, lb. 

Volume Total m³, L, ft³, barrels, UKgal, USgal. 

 

Mass Flow 

lt/day, lt/hour, st/day, st/hour, st/min,  

lb/day, lb/hour, lb/min, lb/s, T/day, T/hour, T/min,  

kg/day, kg/hour, kg/min, kg/s,  

g/hour, g/min,  

Special.  

Volume Flow ft³/h, ft³/min, USgal/day, L/hour, UKgal/h, USgal/h,  

Bar/day, Bar/h, m³/hour, m³/s, m³/min,  

Special. 

Temp. C°, °F, K, °R. 

Density g/cm³, kg/m³, st/yd³, lb/in³, g/L, kg/L, g/mL, lb/ft³, lb/gal. 

Table 7-2 Units Table 

7.13 Password Setup 

● By transmitter 

Config > Password Setup. 

7.14 Parameter Backup 

● By transmitter 

Config > Parameter Backup > Backup/ Restore. 

 

7.15 Languages 

Only English & Chinese are available for the moment. 

● By transmitter 
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User > System Setup > Languages. 

7.16 Timeout 

● By transmitter 

User > System Setup > Timeout > Set > Save. 

Mark: Set it 0 to make it always on. 

7.17 Display Setup 

This is to choose what will be shown on main interfaces, mass, volume, or mass & volume. 

You can activate SET to alternate mass and volume if you choose M&V. 

● By transmitter 

Use > Display Setup > Set > Save.  

7.18 Sensor Status 

Please check the following factors if they are the same as marked on nameplate of sensor when 

transmitter/ sensor is replaced or transmitter is updated. Please modify accordingly if not. 

FLOW CAL: Factory Calibration Factor; 

D1: Low Density Calibration Value      D2: High Density Calibration Value 

K1: Low Density Calibration Time       K2: High Density Calibration Time 

TC: Density Temperature Compensation Factor 

● By transmitter 

Method 1: On main interface, long activate SET & SELECT at the same time, and it will go to 

sensor status interface. 

Method 2: User > Sensor Status. 

● By software 

Tool bar > Functions > Configuration > check the parameters under Flow Rate and Density. 
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Chapter 8 Explosion-proof 

●The meter is processed according to Ex-proof standard GB3836.1-2010 and 

GB3836.4-2010; 

●The meter consists of intrinsically safe sensor, transmitter and connection cable. Sensor 

meets Ex-mark Ex ib IIBT1~T6 Gb/Ex ib II CT1~T6 Gb requirements, and transmitter Ex d[ib] 

II BT4Gb requirements; 

●The sensor is intrinsically safe equipmentcan, with Ex-mark Ex ibIIBT1Gb~T6 Gb/ Ex 

ibIICT1~T6 Gb, and the transmitter with Ex-mark Ex d[ib]IIBT4Gb 

 

 

 

 

 

 

 

 

Pic. 8-1 Ex-proof system 

●The biggest capacitance from intrinsically safe sensor to transmitter allowed is 0.11μF, the 

biggest inductance 0.2mH; 

Name 
Max. Output 

Voltage/ V 

Max. Output 

Current/ mA 

Max. Output 

Capacitance/ μF 

Dirve coil 11.8 100 9.9 

Temp. sensor 6.2 43 790 

Pickoffs 7.8 54 130 

Sensor 

Safety Barrier 

In the Ex d enclosure 

Terminal Terminal 

Main Board 

Power Board 
Transmitter 
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● Ambient temperature: -30~+65°C; 

● The meter shall be well grounded during operation; 

● Do not replace any component or part inside transmitter without manufacturer’s guide; 

● Inner diameter of wiring cable shall be φ8.5 or φ12, external diameter between φ8 & φ8.5 

or φ8.5 & φ12. Please replace wiring cable if wornout; 

● Keep corrosive gas from junction box; 

● Do not install or dismount under inflammable gas environment.  

● Repairs of the flameproof joints may only be made by the manufacturer or on behalf of the 

manufacturer and on his own responsibility. Repair in compliance with the values EN/IEC 

60079-1 is not accepted. 

Chapter 9 Troubleshooting 

 

9.1 Self-diagnosis 

The transmitter & software will self-diagnose once powered on/ connected.  

The transmitter will show error code immediately on the top of display if there is anything 

wrong.  

1.Error 01: Sensor error;       2.Error 02: Temp. sensor overrun; 

3.Error 03: Zero failed;         4.Error 04: Transmitter initializing. 

To callout the interface on software, click tool bar > Functions > Status. The light in front is 

green when everything is fine, but will be red if there is any error. 
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9.2 Troubleshooting 

Error Possible cause 

No display 

Maybe the screen is under auto-off status. 

Check if the voltage between terminal L/+ & N/- is 220V/24V. 

Check if the wiring between display terminal and mainboard is 

loosen or wrong. 

Transmitter operation 

failure 

Check if the wiring between display and mainboard is loosen or 

wrong. 

No Modbus 

communication 

Check if the communication wiring is loosen or wrong. 

Check communication port setting. 

Unstable zero point 

Check if the pipe is full of gas/liquid. 

Check if there is any bubble inside. 

Check if the meter is properly grounded. 

Check if motor, transformer or other electrical equipment is 

near. 

Check if the detector is under mechanical pressure. 

Check if the junction box is kept away from dust and water. 

Flow rate accuracy 

failure 

Check if zero point setting is correct. 

Check if flow unit and min. cutoff value is set properly. 

Check if the meter is properly grounded. 

Check if there is any bubble inside. 

Check if the reference value is correct. 

Density accuracy failure 

Check if the density unit is set properly. 

Check if it is fixed density. 

Check if the pipe is full of fluid, without any other impurity. 

Check if the temperature measurement is correct. 

Check if the meter is rusted or corrupted. 

Check if there is any impurity piled inside. 

Temp. accuracy failure 

Check the wiring of transmitter. 

Check if platinum resistor PT100 is correct. 

Check if the unit is the same. 

Signal output failure 
Check if the suspicious output signal setting is correct. 

Check if the output is normal. 

Please contact the manufacturer if problem can not be solved. 

Table 9-1 Troubleshooting 
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Chapter 10 Completeness 

 

The meter consists of sensor, transmitter and the connection cable. Please mark in PO if 

companion flange is needed. Along with the meter, there are use manual, certificate of 

qualified product & packing list. 

 

Chapter 11 Transport and Storage 

 

Please keep the meter in good condition during transport, better packed in the original  

package from the manufacturer. 

Please make sure the site meets following requirements, if keep the meter in storage. 

 

a) Waterproof and moisture-proof; 

b) With few mechanical vibration and crush; 

c) Temperature from -30°C to +65°C; 

d) Humidity less than 80%, better about 50%; 

e) Please clear up the sensor if storage used one; 

f ) Performance will be influenced if storage in the open. 
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Chapter 12 Limited Warranty 

Meters are warranted for two years from the date printed on nameplate, within which 

Sealand will offer technical support and spare parts for free if the meter doesn’t work well 

during proper operation according to the manual. Besides, Sealand will continue to provide 

life-long maintenance services afterwards. 

However, all replacements or repairs necessitated by inadequate maintenance, normal wear 

and usage, unsuitable power sources or environmental conditions, accident, misuse, 

improper installation, modification, repair, use of unauthorized replacement parts, storage or 

handling, or any other cause not the fault of Sealand are not covered by this limited warranty, 

and shall be at buyer’s expense. Sealand shall not be obligated to pay any costs or charges 

incurred by buyer or any other party except as may be agreed upon in writing in advance by 

Sealand. All costs of dismantling, reinstallation and freight and the time and expenses of 

Sealand’s personnel and representatives for site travel and diagnosis under this warranty 

clause shall be borne by buyer unless accepted in writing by Sealand. Goods repaired and 

parts replaced by Sealand during the warranty period shall be in warranty for the remainder 

of the original warranty period or ninety days, whichever is longer. The limited warranty is the 

only warranty made by Sealand and can be amended only in a writing signed by Sealand.  

The warranties and remedies set forth above are exclusive. There are no representations or 

warranties of any kind, express or implied, as to merchantability, fitness for particular 

purpose or any other matter with respect to any of the goods or services. 
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